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The  GAB’er
The Newsletter of the Greater Albany Apple Byters

This month we will take a look at the new version of 
Adobe’s new Photoshop Elements 8.

To find out what’s happening, GAAB is the place to be. So 
be sure to be at our December meeting and every meeting 
to find out the best information about the Mac.

I will try one more time to use DimDim. However, I am 
beginning to have my doubts about using the program. So 
try to be at the meeting if at all possible.

The December meeting will be held at St. Mary’s Hospital 
in the Leonard Board Room on Wednesday, December 9, 
2009.  The meeting will begin at 7 p.m. St. Mary’s Hospital 
is located at 1300 Massachusetts Avenue in Troy NY. 

However, the best route to take from the Northway is the 
following:  Merge onto NY-7 East from the Northway. 
Follow Route 7 to Troy where it becomes Hoosick Street. 
Turn left on Oakwood Avenue (10 Street/NY-40) which is 
the first light after the bridge and bare right. Turn right on 
Sausse Avenue. Turn left onto Lindenwood Court. When 
you come to the first entrance to the hospital parking lot, 
turn left and park. 

Apple Offers Concert 
Downloads via iTunes
Live Nation and Apple have teamed up to offer exclusive 
downloads of concerts via iTunes.

Live Nation is one of the largest live convert recording 
companies around and their recordings are now available 
on iTunes for download.

According to the press release, “Live Nation Studios will 
now offer exclusive recorded and filmed concerts from 
its network of “wired” venues for purchase and download 
only on iTunes. Exclusive live recordings from OK Go, 
Jesse McCartney, Saving Abel, A Fine Frenzy, Duffy, Plain 
White T’s and Ziggy Marley, to name a few, have been 
released this week, with many more to follow.”

Apple has added a new area in iTunes called Live Music 
that allows you to search for and purchase your favorite 
concerts.

Apple has been involved in the music and movie 
distribution business for a few years now, so live music 
seems to be a logical step in the right direction for the 
Cupertino-based company.
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The Greater Albany Apple Byters is an Apple 
Computer User Group. Meetings are held the second 
Wednesday of each month (except July and August) 
in Room 212 of Troy High School, located on Burdett 
Avenue, Troy, NY.

Annual membership fee is $10.00. Membership privi-
leges include this newsletter, access to a large public 
domain software and video/audio tape library, local 
vendor discounts, special interest groups, and other 
special offers.

Contents of The GAB’er are copywriten, all rights 
reserved. Original articles may be reprinted by not-
for-profit organizations, provided that proper credit 
is given to the author, The GAB’er, and a copy of the 
publication sent to The GAB’er editor.

The views expressed herein are the sole responsibility 
of each author, and do not necessarily represent the 
views of the Greater Albany Apple Byters.

Note: Trademarks used in this newsletter are recog-
nized as trademarks of the representative companies.
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Continued on page 6.

Handbrake Gets 64-bit Snow 
Leopard Love
by Liam Cassidy, the AppleBlog

Mac OS X is a wonder. When it 
comes to personal information 
management, entertainment 
and the Internet, it’s got all 
the basics covered. Beyond 
that, there are a handful of 
“essential” apps most Mac 
owners install on a new 
machine within minutes of 

booting it up for the first time. Handbrake is undoubtedly 
one of those essentials. And it just got a serious new 
upgrade.

Handbrake is a very handy (pun intended) DVD-ripping 
utility that converts DVDs to self-contained video files 
that can be played back on a computer or mobile device. 
(Contrary to the outright lies of major motion picture 
studios, there’s nothing wrong with having digital backups 
of movies you already own). In addition, DVDs can be 
converted into a number of formats, resolutions and aspect 
ratios. For many years, it has served as the single easiest 
way to get my movies off-of DVD discs and onto my iPods, 
iPhones and even my PSP. 

The latest release, Handbrake 0.9.4, includes support for 
Snow Leopard, and is also available in 64-bit editions for 
both Leopard and Snow Leopard. It also adds the ability 
to include multiple subtitle tracks to exported video and a 
new “live preview” for viewing the likely outcome of an 
export before committing to a lengthy rip.

According to the release notes on the Handbrake website, 
the latest version includes new features like “macroblock 
tree rate control” and “weighted P-Frame prediction.” I’ve 
absolutely no idea what any of that means, and although 
they do provide links to explanatory articles, it made my 
head swim. I’ll just assume it’s all very swish and futuristic 
and good for my rips.
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Keep Your Guard Up When
Using Twitter and Facebook

by Kim Komando

Internet SIG

You’re careful about what you post online. You know 
Facebook and Twitter posts can harm your dating and 
job prospects. And thieves can use the sites to target you.

But there’s much more to maintaining your security and 
privacy. Criminals and marketers have found new ways to 
use Twitter and Facebook. If you’re not paying attention, 
it’s easy to get taken.

Don’t be fooled by shortened URLs

Twitter limits posts to 140 characters. So, shortened URLs 
(Web addresses) are common. You’ll also see them on other 
sites. URL services create the shorter addresses.

Unfortunately, unless you take extra steps, you don’t know 
where the link leads without clicking it. You could be sent 
to a porn site or worse—an attack site.

TweetDeck, a desktop program, will protect you. Or use 
the Long URL Please add-on for Firefox. Both reveal full 
URLs. Sites Untiny and PrevURL show full URLs in any 
browser.

Beware “friends” in need

Unsurprisingly, criminals are stealing Facebook log-in 
credentials. Accounts contain sensitive information, but 
there’s an easier way to profit.

Criminals send messages to your contacts, pretending to 
be you. You were mugged while traveling overseas, they 
say. You need money to get home. They hope to milk your 
contacts.

Expect to see variations on this scam. For example, a 
similar e-mail scam targets grandparents of military 
members.

A quick call can expose such a scam. To protect your 
contacts, keep your security software current and guard 
your passwords.

Watch out for applications

Facebook applications make the site more entertaining but 
pose an unexpected risk.

They can access your profile. The developer can read your 
wall posts or collect your contact information.

Your applications see everything on Facebook that you 
can. You could be exposing your contacts’ data. Or, your 
contacts could expose yours.

What can developers do with profile information? They 
may steal your identity. More likely, they’ll use your data 
in ads.

Developers may sell advertising within applications. They 
are barred from using your personal information. Still, 
some may violate Facebook’s policies.

To prevent this, only install Verified applications. These 
have a green checkmark in the application directory.

To uninstall apps, click Settings>>Application Settings. 
Click the X next to an application to remove it.

Facebook has promised changes to prevent misuse of 
data. You should soon have more control over what data 
applications can access.

Facebook may use your profile pictures in ads it sells. 
This happens when you become a fan of a product or 
publication. These social ads are displayed only to your 
contacts.

Continued on page 8.
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Education SIG
Obama Launches New STEM Initiatives

President Announces Efforts to Boost
Math, Science Education

by Maya T. Prabhu, Assistant Editor, eSchool News

P r e s i d e n t  O b a m a 
announced a nationwide 
push to improve American 
students’ performance and 
interest in STEM fields.

President Barack Obama 
on Nov. 23 announced the 

launch of several nationwide programs to help motivate and 
inspire students to excel in science and math, including a 
grassroots effort called “National Lab Day” and a White 
House science fair.

Leadership tomorrow is dependent on how America’s 
students are educated today, Obama said in morning 
remarks.

“The key to meeting these challenges--to improving 
our health and well-being, to harnessing clean energy, 
to protecting our security, and succeeding in the global 
economy--will be reaffirming and strengthening America’s 
role as the world’s engine of scientific discovery and 
technological innovation,” he said. “The hard truth is that 
for decades we’ve been losing ground.  One assessment 
shows American 15-year-olds now rank 21st in science 
and 25th in math when compared to their peers around 
the world.”

Obama was referring to results from the most recent 
Program for International Student Assessment, or PISA. 
Some experts caution that PISA is different from other 
tests, especially those in the United States, and makes 
American kids look worse than other tests do.
 
Office of Science and Technology Policy Director John 
Holdren reiterated Obama’s sentiment in a conference 
call with reporters.

“The president has been clear throughout his campaign 
that STEM [science, technology, engineering, and math] 
is a priority, not only because we need today’s students 
to become tomorrow’s leaders in innovation and help our 
economy, but also because we need to increase STEM 

interest and skills overall for everybody. We need a 
science-savvy citizenry to help decide STEM policy and 
much more,” he said.

Obama identified three overarching priorities for STEM 
education: increasing STEM literacy so all students can 
think critically in these subject areas; improving the quality 
of math and science teaching so American students no 
longer are outperformed by those in other nations; and 
expanding STEM education and career opportunities for 
underrepresented groups, including women and minorities.

To help meet these goals, Obama announced a series of 
high-powered partnerships involving leading companies, 
foundations, nonprofit organizations, and science and 
engineering societies, all of which are dedicated to moving 
American students from the middle to the top of the pack 
in science and math achievement over the next 10 years.
The partnerships include:

  •  Time Warner Cable’s “Connect a Million Minds” 
Campaign, which aims to connect more than one 
million students to highly engaging after-school 
STEM activities that already exist in their areas.

  •  Discovery Communications’ “Be the Future” 
Campaign, which will create content that reaches 
more than 99 million homes, including a public 
service announcement campaign and the creation 
of interactive education content through Discovery 
Education.

  •  Sesame Street’s Early STEM Literacy Initiative will 
consist of a major focus on science and math for young 
children with “My World is Green and Growing.” The 
program will be part of a two-year science initiative 
designed to increase positive attitudes toward nature, 
deepen children’s knowledge about the natural world, 
and encourage behavior that shows respect and care 
for the environment.

  •  National STEM Game Design Competitions, which 
will be sponsored by the MacArthur Foundation, Sony 
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Computer Entertainment America, the Entertainment 
Software Association, and its partners, is a set of 
nationwide competitions that include the design of 
the most compelling, freely available STEM-related 
video games for children and youth. 

  •  “National Lab Day” is a grassroots effort to bring 
hands-on learning to 10 million students by upgrading 
science labs, supporting project-based learning, and 
building communities of support for STEM teachers.

On the conference call, Domestic Policy Director Heather 
Higginbottom pointed out that, as Obama said in his 
speech, solving the STEM crisis will require “all hands 
on deck,” meaning parents, students, private and public 
institutions, and teachers need to work together.

One reporter noted that many teachers aren’t highly 
qualified to teach STEM disciplines and asked what the 
administration would do about this. “Teacher quality is 
one of the major areas that the [Education Department] 
wants to reform. We’re hoping these types of national 
projects will inspire teachers to want to take part in STEM,” 
Higginbottom said.

Holdren added that parents are crucial in stoking students’ 
desire to learn about STEM subjects, and he hopes parents 
and kids will reinforce each other’s enthusiasm.

To help lead the “Educate to Innovate” initiative, Obama 
has tapped Xerox Chief Executive Ursula Burns, former 
Intel Corp. CEO Craig Barrett, Time Warner Cable Inc. 
CEO Glenn Britt, and former astronaut Sally Ride.

Burns, a mechanical engineer, joined Xerox as a student 
intern nearly 30 years ago and became CEO in July. She 
said in a statement that companies like Xerox depend on 
the fresh ideas of people to succeed.

“If we inspire young people today, we secure our ability 
innovate tomorrow,” she said.

In an afternoon event, a coalition of educators, science and 
engineering associations, and philanthropic organizations 
launched National Lab Day as a way to bridge the gap 
between scientists and teachers.

Jack D. Hidary, chairman of National Lab Day, encouraged 
others to get involved in the grassroots effort through its 
web site, NationalLabDay.org, which automatically will 
match volunteers to requests from educators on the basis 
of geography and interests. The web site also provides 
resources and ideas for hands-on learning experiments and 
invites the public to suggest new materials.

“Our children deserve a world-class science and 
math education that includes exciting, hands-on lab 
experiences,” Hidary said. “Whether you are a Nobel 
Prize-winning scientist, a ‘Mythbusters’ fan, a tinkerer, 
or a parent, you can help bring students the enjoyment of 
learning through real challenges.”

Additionally, Obama announced the launch of a new 
science fair to be held at the White House each year.

“We’re going to have an annual science fair at the White 
House with the winners of national competitions in science 
and technology. If you win the NCAA championship, you 
come to the White House. Well, if you’re a young person 
and you’ve produced the best experiment or design, the 
best hardware or software, you ought to be recognized for 
that achievement, too,” he said. “Scientists and engineers 
ought to stand side by side with athletes and entertainers 
as role models, and here at the White House we’re going 
to lead by example. We’re going to show young people 
how cool science can be.”

The Time Warner launched of a new philanthropic initiative 
in conjunction with a White House plan to strengthen 
America’s economic competitiveness by improving 
education and interest in science, technology, engineering 
and math (STEM). 

The company’s initiative, Connect a Million Minds 
(CAMM), is a five-year, $100 million program to address 
a declining proficiency in STEM that puts America’s 
children at risk of not competing successfully in a global 
economy. Using its media assets, Time Warner Cable 
will create awareness of the issue and inspire students by 
connecting them with hands-on, after-school opportunities 
to experience STEM in non-traditional ways. 

Time Warner Cable Chairman, President and CEO Glenn 
Britt, who will join President Obama at the White House 
announcement, said, “We cannot let American students 
continue to fall behind in the areas of science, technology, 
engineering and math. Time Warner Cable is uniquely 
positioned to provide real solutions that get students excited 
about learning opportunities in these areas. Our research 
shows that there is an understanding of the importance 
of this issue, but also a lack of awareness of the learning 
opportunities available locally to children. We have two 
goals. One, we want to help parents understand the critical 
importance of their children’s math and science education 
to a successful future--their own and the country’s. And 
two, we want children to see that math and science can be 
fun through engaging, hands-on experiences. We hope that 
will inspire students to pursue higher education and careers 
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Apple Ambassador
Continued from page 2.

in STEM fields, filling a critical but dwindling pipeline in 
America’s workforce.” 

Anchoring the initiative is a unique website, www.
connectamillionminds.com, using zip-code search to 
connect students to STEM learning opportunities in their 
communities. The website also challenges parents, after-
school program administrators and community members to 
pledge to connect children in their lives with the wonders 
of science and math. Time Warner Cable has set a goal of 
connecting 1 million children by 2014. On the website, 
participants can watch video case studies of inventors and 
technologists talking about their projects, and post photos 
and narratives about their STEM experiences, creating a 
community of people who share a common interest and 
passion for scientific pursuits. 

Initial users of the website included volunteer coordinators 
of FIRST (For Inspiration and Recognition in Science and 
Technology), a non-profit organization that inspires young 
people to be science and technology leaders. “Very well 
done,” commented Myrle McLernon, a FIRST robotics 
mentor. “I am extremely pleased that Time Warner Cable 
is using its influence to create a positive force for our 
children. This program will make thinking and problem 
solving a mainstream process for all students.” 

Connect A Million Minds has partnered with FIRST and 
the Coalition for Science After School (CSAS) to give the 
program national scope and local application. The program 
highlights FIRST robotics competitions around the country 
and encourages volunteers and mentors to support teams 
of young participants. 

“The importance of repairing our fragile global economy, 
combating the effects of climate change, replacing fossil-
fueled energy production, and addressing worldwide 
public health needs has never been more critical,” said 
Dean Kamen, inventor and chief executive officer of 
DEKA Research & Development and founder of FIRST. 
“But even as many scholars agree that improvements in 
science and technology are needed to meet these issues 
head on, the single most important challenge will be to 
produce the innovative, passionate scientists, engineers, 
and technicians who will show us the way. I wholeheartedly 
applaud Time Warner Cable and their efforts to help kids 
compete in the global economy and thank the corporation 
for allowing FIRST to be a part of this groundbreaking 
STEM initiative.” 

CSAS is leading development of the national database of 
STEM activities and using its national presence and local 
partnerships to engage after-school STEM programs in the 
Time Warner Cable initiative. 

The introduction of a 64-bit version is good news for those 
of us using true 64-bit multi-core processors, though the 
performance increase is a fairly modest 10 percent. The 
software also supports non-DVD encoding, which is great 
news for those of us who do a lot of video editing. (I prefer 
to use Final Cut but often have to import raw data into 
iMovie only to export it out to a format Final Cut will 
accept. Handbrake won’t cut out this extra conversion step, 
but it performs far faster than the monolith that is iMovie 
and provides more flexibility in export formats.)

It’s not all about video, either. Handbrake offers great audio 
encoding options, including the newly-added ability to 
encode AAC using OS X’s Core Audio (which means far 
higher quality than was possible previously).

Of course, there are a lot of other software titles that offer 
similar functionality (Aimersoft’s popular DVD Ripper, for 
instance) but Handbrake is free. Although this means it has 
no official support, it does enjoy an active and enthusiastic 
user community so if you get stuck you won’t have far to 
go to find answers and help.

If you are using a 64 bit machine and want to get the 
full 64-bit goodness from Handbrake, you’ll need the 
64-bit version of VLC Player, the latest nightly builds of 
which can be found at http://nightlies.videolan.org/build/
macosx-intel/?C=M;O=D. (Please note that VLC Player 
64-bit is beta software and as such offers no end-user 
support.) Handbrake 0.9.4 is available from the Handbrake 
website (http://handbrake.fr/index.php) now.

There’s an old proverb in the video encoding world: 
“Speed, size, quality: pick two.” It means that you always 
have to make a trade-off between the time it takes to 
encode a video, the amount of compression used, and the 
picture quality. Well, this release of HandBrake refuses to 
compromise. It picks all three.

The following are the features you will find in HandBrake:

x264 

A large portion of these speed, size, and quality 
improvements come to us for free, from the x264 project. 
The past year, like every year, has seen some massive 
improvements for that video encoding engine. As always, 
it has been further hand-optimized for better performance. 
But it has also gained new features like macroblock tree 
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rate control and weighted P-Frame prediction. The end 
result? Better picture quality, at a smaller size, faster.

So, if x264 alone gives us smaller, better, faster encodes...
what have HandBrake’s developers been doing over the 
past year?

Oh, all sorts of things :-)

New build system 

HandBrake has a new, much improved compilation system, 
which allows easy 64-bit and parallel builds, as well as 
providing easy extendability for future improvements to the 
application. 64-bit builds tend to perform approximately 
10% better than their 32-bit brethren. There is no Snow 
Leopard magic here: the performance gains can also be 
realized on Intel Macs running 10.5, as well as Linux 
systems.

Soft subtitles 

HandBrake can now include subtitle tracks that can be 
turned on and off, instead of rendering them onto the video 
track permanently (which also reduces video compression). 
This means you can include Closed Captioning data from 
DVDs and TV broadcasts, or find SRT text subtitle files 
on the ‘net and include them. When using the Matroska 
container, you can also store the graphical subtitle images 
(VobSubs) from a DVD as a separate track. An added 
benefit is that multiple subtitle tracks can be included in 
the same output video.

Live preview 

Ever wished you could test HandBrake settings before 
spending hours on a full encode? Now, you can.

The picture settings and preview sheet has been broken out 
into a filters and picture settings inspector, and a preview 
window. The preview window can show you still frames 
from your source, like always. But it also lets you start 
to encode a short clip from the current preview with the 
currently selected settings, and view the results right there 
inside of HandBrake.

Better input support, for DVD and non-DVD sources 
alike 

HandBrake now uses a better DVD reading library called 
libdvdnav. This means it can now read some DVDs it had 
trouble with before, and it can also select different angles 
on a DVD. As well, some bugs in underlying libraries 
have been patched.

For non-DVD sources, HandBrake now offers improved 
transport stream support, especially for high definition 
sources. A number of decoding bugs have been resolved 
as well, so Windows users will no longer need fear AAC 
audio, nor Mac users fear VC-1 video.

Constant quality encoding 

No more looking for the perfect bitrate for a source--
HandBrake is migrating to quality-based encoding. This 
means that instead of telling encoders to use a specific size 
and vary quality to meet it, we tell the encoder to vary size 
to meet a given quality level. Overall quality improves, 
since bits are spent only when they are needed, and are 
saved when they are not. While this means output size 
is somewhat unpredictable, the results in picture quality 
speak for themselves.

As part of this change, the quality slider has been made 
more prominent, and now works off the quality values 
used by the video encoders, instead of a confusing, custom, 
percentage scale.

Another result is that 2-pass encoding is not needed. A 
single pass at a constant quality provides just as much 
compression efficiency as two passes at an average bitrate.

Presets 

There are no more presets for the PSP, PS3, or Xbox 
360. Quite frankly, they didn’t work well. None of the 
development team members own the devices, so testing 
was minimal and support was nonexistent. Keeping up 
with the firmware vagaries and ambiguous specifications 
of these devices was not fun--we get enough of that from 
Apple’s kit, and those we all have around to test on. The 
new “Normal” preset should work perfectly fine on any 
device that supports standard Main Profile H.264 with 
AAC-LC audio in an MP4 file, which the PS3 and 360 
ostensibly do.

There are no more Film, Animation, or Television presets. 
Instead of a confusing series of content-targeted presets, 
there is now a single, constant quality, High Profile preset 
with automated filtering and all the H.264 bells and 
whistles. This preset should work on the PS3 and 360 too, 
although we make no promises.

It is now possible to import individual presets in all the 
graphical interfaces, and to export them as well, in the 
Mac and Linux GUIs.
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Internet SIG
Continued from page 3.

Focus on what we do best 

As we’ve had on our roadmap for quite awhile now, one of 
our goals for version 0.9.4 was to refocus on HandBrake’s 
key strengths and to remove dead weight. As part of this 
process, several containers and a codec have been removed 
from HandBrake.

AVI: AVI is a rough beast. It is obsolete. It does not 
support modern container features like chapters, muxed-in 
subtitles, variable framerate video, or out of order frame 
display. Furthermore, HandBrake’s AVI muxer is vanilla 
AVI 1.0 that doesn’t even support large files. The code has 
not been actively maintained since 2005. Keeping it in the 
library while implementing new features means a very 
convoluted data pipeline, full of conditionals that make 
the code more difficult to read and maintain, and make 
output harder to predict. As such, it is now gone. It is not 
coming back, and good riddance.

OGG/OGM: HandBrake’s OGM muxer is just as out 
of date. It hasn’t been actively maintained in years 
either, and it too lacks support for HandBrake’s best 
features. It requires conditionals to work around missing 
functionality too...only this one gets tested so infrequently 
the conditionals were never even put in the code, so it just 
fails when you try to do anything advanced. This one is 
not coming back either. And yes, we’re aware of HTML 
5. For patent-free muxing, HandBrake still has Matroska, 
which is a much better container anyway.

XviD: HandBrake, these days, is almost entirely about 
H.264 video, aka MPEG-4 Part 10. This makes it rather...
superfluous to include two different encoders for an older 
codec, MPEG-4 Part 2. When choosing between FFmpeg’s 
and XviD’s, it came down to a matter of necessity. We 
need to include libavcodec (FFmpeg) for a bunch of other 
parts of its API, like decoding. Meanwhile, XviD’s build 
system causes grief (it’s the most common support query 
we get about compiling, after x264’s requirement of 
yasm). Since we mainly use MPEG-4 Part 2 for testing/
debugging, and recommend only H.264 for high quality 
encodes, Xvid’s undisputed quality edge over FFmpeg’s 
encoder is inconsequential, while FFmpeg’s speed edge 
over XviD is important to us.

But wait, there’s more! 

Audio-video synchronization has been further improved.

HandBrake can now pass-through DTS audio from a source 
when encoding to the Matroska container, just like it has 
previously for AC3 audio.

Mac users can now encode AAC audio using OS X’s Core 
Audio, rather than using the open source libfaac. Core 
Audio offers far superior audio quality.

A new custom anamorphic mode allows precise control of 
all parameters, for power users.

Decomb now offers an optional, slower, better quality 
deinterlacing method called EED12.

Library updates for (besides x264) FFmpeg, libtheora (1.1), 
libmp4v2, libfaac/faad, libvorbis, and libmkv.

Of course, there have also been countless improvements 
to the user interfaces, and many technical changes under 
the hood to improve things like sample interleaving and 
framerate shaping.

To prevent Facebook from using your photo, click 
Settings>>Privacy Settings. Select News Feed and Wall. 
On the Facebook Ads tab, find the Appearance dropdown 
box. Select “No one” and click Save Changes.

And remember that ads on networking sites are much like 
newspaper classifieds. They’re not vetted. Products may 
not work as promised. Or, they may advertise sham work-
from-home opportunities.

Quizzes and games

Quizzes and games often fall into the applications category. 
But they pose a threat different from other applications.

Quizzes and games may trick you into revealing personal 
information. Take, for example, the Twitter porn names 
game. Users were encouraged to create and post their 
porn names.

You create the name from your first pet’s name and the 
street you grew up on. Some versions also call for your 
mother’s maiden name or a teacher’s name.

Many jumped on the trend and posted their names on 
Twitter. This information is often used in online security 
questions and password resets. The game may have been 
an attempt to trick users into revealing personal data.

Watch out for similar social engineering attacks. The best 
protection is vigilance—and a healthy dose of skepticism.
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Betanews reports (via The Loop) on data from market research firm NPD showing that Apple garnered 48% of the U.S. 
PC industry’s retail revenue last month.

In October, Mac US retail desktop computer revenue share was 47.71, percent up from 33.44 percent a year earlier, 
according to NPD. It’s a stunning number, given just how many Windows PC companies combined command so much 
more market share, while competing for the same revenue share.

While NPD’s Stephen Baker points to a confluence of events, including Apple’s refresh of its iMac line during the month 
and a decline of PC sales ahead of the launch of Windows 7, as being responsible for Apple’s performance during the 
month, he also notes that the trend is not likely to continue. Data from previous months, however, shows that Apple 
had been performing quite well even back in April of this year, when it captured 45% of the desktop retail revenue.

NPD notes that Apple’s strong revenue performance is a direct result of its average selling prices, which are nearly 
three times that of Windows PCs. That difference has enabled Apple to claim high revenues despite significantly lower 
unit market share than top Windows-based PC vendors.

One factor helping Apple is average selling price. The Mac maker has largely chosen not to compete with Windows PC 
manufacturers below $1,000. While price wars continue at the low end among Windows PC manufacturers, Apple’s 
entry-level iMac starts at $1,199. True, Apple offers the Mac mini for $599 or $799, but the ASP is considerably higher 
than comparably priced Windows PCs. Low-cost Windows PCs typically come with monitor, keyboard and mouse, 
which are all extra-cost items for Mac mini unless the buyer uses existing gear.

Apple’s performance isn’t as strong in the notebook segment, where it commands only a 34% share of the industry 
revenue, although that number still ranks Apple as a major player in the notebook field.

Apple Records Nearly Half of U.S. PC Desktop 
Retail Industry Revenue
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Nearly a month before Apple updated its iMac line, 
French site Mac4Ever published a wide-ranging article 
revealing a number of tidbits on various topics obtained 
from its sources. At the time, the report was simply one of 
many circulating rumors about Apple’s upcoming product 
announcements.

Mac4Ever’s details, however, proved to be remarkably 
accurate once Apple made public its new products. The 
report correctly predicted the inclusion of an SD card slot 
and quad-core processors in the revised iMac, as well 
as pinpointing the Magic Mouse and the new aluminum 
Apple Remote. In fact, the only piece of information from 
Mac4Ever’s report that has been shown incorrect was one 
source’s claim that Apple might even go so far as to use 
Intel Xeon processors in the new iMacs.

Given the accuracy of most of Mac4Ever claims, a re-
examination of the report’s other, longer-term predictions 
seems appropriate. First, the report claimed that Apple 
was well on its way to updating its iLife and iWork 
applications to move to 64-bit and to take full advantage 
of the improvements included in Snow Leopard.

On the software side of things, Apple is probably deep into 
switching its group of iApps over to 64 bits, and taking full 
advantage of the new Snow Leopard technology. We’ve 
also been told that Leopard’s compatibility hasn’t been 
settled on yet, but that the 2010 suite would only support 
Macs with Intel-based processors.
A transition to Intel-only compatibility for the next-
generation of iLife and iWork would not be a major 
surprise, as Snow Leopard itself dropped support for PPC-
based Macs. What might be considered a bigger surprise 
is the possibility of the next version of iLife and iWork 
not supporting Mac OS X Leopard. Depending on when 
that software revision occurs, it could mark a very short 
turnaround from Snow Leopard’s release in late August to 
discontinuation of support for Leopard, the immediately 
previous operating system version, in the iLife and iWork 
suites.

The question of when we can expect to see the next 
generation of iLife and iWork suites has also yet to be 
answered. Early in its development, iLife revisions were 
issued on a yearly basis each January at Macworld San 
Francisco. But as the suite matured, release cycles have 
slipped to closer to 18 months, with iLife ‘06 having 

Rumors Revisited: Next-Generation iWork and 
iLife Plans? Apple Tablet Design Surprise?
by Eric Slivka, MacOSRumors.com

been released in January 2006, iLife ‘08 in August 2007 
(skipping an “iLife ‘07” release), and iLife ‘09 in January 
2009. iWork releases have coincided with iLife updates 
since the productivity suite’s introduction in January 2005.

Consequently, if Apple holds closer to its ~18-month 
release cycle going forward, users could expect the next 
generation of iLife and iWork suites to possibly be released 
in mid-2010, probably to be branded as “iLife ‘11” and 
“iWork ‘11” if 2007’s pattern is any indication.

Apple has also recently dropped the “’09” designation from 
its iLife and iWork web pages and retail boxes, suggesting 
that the company is planning to continue selling the current 
versions of those suites well into 2010 and does not wish 
their names to make them appear outdated.

Comparison of Original (Left) and New (Right) iLife ‘09 Retail Boxes

The second still-outstanding claim from Mac4Ever relates 
to Apple’s much-rumored tablet, which has recently been 
reported to be delayed until the second half of 2010, 
although the veracity of the claim is unknown. Mac4Ever’s 
claim, however, provides only a vague suggestion that the 
tablet will be unlike any concept designs or renditions that 
have been floating around in recent months.

Concerning MacTablet, it will indeed be produced, but 
it will be far different from the concepts that have been 
announced so far on rumor sites.
The article offers no further information on what we 
can expect to see when Apple’s tablet finally makes its 
appearance, but this claim and the report regarding iLife 
and iWork do carry some additional weight and bear close 
watching in the months ahead due to the accuracy of other 
claims made at the same time.
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Visit GAAB on the Internet at http://www.applebyters.com

GAAB Internet Addresses To start or renew your GAAB 
membership, see Cecilia MacDonald 
or send your fees payable to her at 
the following address:

Cecilia MacDonald
260 Sever Road
Delanson, NY 12053

Names E-Mail Addresses
Aaron Ambrosino ...........aambrosi@mac.com
Gary Blizzard .................gmblizzard@aol.com
Steve Bradley .................ssbradley@adelphia.net 
John Buckley ..................jbuckley@nycap.rr.com 
Anthony Eldering ...........tonye11@verizon.net 
Trudy Ellis ......................TE52@earthlink.net
Lilajane Frascarelli .........afrascar@nycap.rr.com 
Les Goldstein .................lgoldst1@nycap.rr.com 
Richard Hester ...............hesterFP@capital.net 
George Johnsen ..............gjohnsen@sprynet.com 
Judy and David Kaskel ..jak@nycap.rr.com
Ottmar Klaas ..................ottmar.klaas@gmail.com
Thomas Levanduski .......msglevanduski@aol.com
Cecilia MacDonald ........cecilia@midtel.net 
Roger Mazula .................aluzam@aol.com 
Brendan O’Hara .............bohara1@nycap.rr.com 
Linda Rackliffe ..............revlindarackliffe@frontiernet.net
Eric/Lee Rieker ..............Erieker@aol.com
Judith Schwartz ..............jfschwartz2@earthlink.net
Saul Seinberg .................saul.seinberg@gmail.com
Bill Shuff ........................wjs206@earthlink.net 
Nancy Suess ...................nesuess@aol.com 
Edward Walsh ................ewalsh@nycap.rr.com 
Shelly Weiner .................olliedawg@yahoo.com
Lou Wozniak ..................louwx08@mac.com
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We present the Ultimate Mac Troubleshooting Guide, so you can banish the 
peskiest problems once and for all. 

Mac problems? Isn’t that an oxymoron? If you just switched to the Mac from 
Windows, you might be thinking that you accidentally picked up one of your old 
PC magazines--and, by the way, we’ve got solutions to the seven most common 
problems switchers encounter, too. If you’re a longtime Mac user, you could even 
be wondering where we get off accusing the Mac platform of being problematic.

Using a Mac is generally painless and trouble free, but things 
can go wrong. Usually they’re not catastrophic (for solutions 
to true Mac disasters, click here). Sometimes the things that 
go wrong are those little annoying things that you just shrug 
off--over and over, until you finally have to deal with them.

We’re here to help you tackle the 50 most common problems 
in eight different categories, once and for all. If your problem 
isn’t covered here, email us at ask@maclife.com, and we’ll 
try to solve it in a future issue.

General Mac Problems

The Mac OS is, fundamentally, as trouble-free as operating 
systems get. But nothing’s perfect. Here’s what to do when 
you hit a snag.

1. I want a tabbed finder.

Download the incredibly versatile Path Finder ($40, www.
cocoatech.com), which gives you all sorts of features 
that are missing from the Finder, such as tabs, stacks, 
bookmarks, and panes. Sounds like fun to us

Now THIS is the Finder we’ve always dreamed of. Thanks, Path 
Finder!

Special GAAB Addendum
50 Common Mac Problems Solved
by The Mac|Life Staff & Scott Rose

2. I can’t print anymore.

This could be caused by a variety of different issues 
relating to your printer hardware or printer drivers, so you 
may need to contact the printer manufacturer for more 
help. But if your Mac is causing the problem, it’s always 
a good idea to reset your entire printing system by going 
into your Print & Fax System Preference, right-clicking 
in the printer list, and choosing Reset Printing System.

3. I travel all over town with my MacBook, and I’m 
sick of reconfiguring my settings every time I show up 
at a location I’ve been to before. Why can’t my Mac 
remember various location settings for me--my default 
printer, mounted servers, iChat screen name, Bluetooth 
settings, everything?

Try NetworkLocation ($29, www.networklocationapp.
com), which can perform dozens of actions on your Mac 
whenever you switch to a new location. Best of all, its 
AutoLocate feature will determine where you are, using 
the same SkyHook Wireless Wi-Fi Positioning System 
that your iPhone uses, and it will automatically change 
all of your settings for you.
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If you frequently switch physical locations, NetworkLocation can 
save you both time and headaches changing your Mac’s settings.

4. I forgot my OS X password.

After retyping your password very carefully at least twice 
to make sure you just didn’t mistype it, you’ll need to haul 
out your OS X install disk, insert it into your Mac and 
restart holding down the C button. After selecting your 
language of choice, in the menubar, select Utilities > Reset 
Password. Follow the directions and there you go. Just try 
not to get a lobotomy after resetting it!

5. My CD or DVD is stuck in the optical drive and won’t 
come out when I press Eject.

After holding down the eject button for several seconds 
to no avail, restart your Mac and hold down the primary 
button on your mouse--the trackpad button will work as 
well if you’re on a MacBook--and during startup the disk 
should eject.

6. My Mac is not recognizing devices plugged in to one 
of my USB ports.

First, make sure your Mac’s firmware is up to date--check 
Software Update and the Apple Support Downloads page 
(support.apple.com/downloads/) and install any firmware 
updates you find for your machine.

If nothing happens, turn off your Mac, unplug the power 
cable, disconnect all peripherals, and let it sit for five 
minutes. Plug it back in, reconnect the keyboard and 
mouse, turn it back on, and try the USB ports again.

Check the Support Downloads page for firmware updates for 
your Mac.

If they’re still unresponsive, you will need to reset the 
PRAM (parameter RAM) and NVRAM (nonvolatile 
RAM), which stores some system and device settings 
that your Mac accesses on startup. Shut your Mac down. 
Then position your fingers above the Command, Option, 
P, and R keys on your keyboard. Turn the Mac on, then 
immediately press and hold those four keys before you see 
the gray screen. Keep them pressed until the Mac restarts 
again and you hear the startup chime for the second time. 
Then let ’em go. When your Mac is finished starting up, 
check those pesky USB ports.

If they’re still not behaving, there’s one more thing you 
can try before making a Genius Bar appointment: resetting 
the SMC, or system management controller. Directions 
for resetting the SMC on your MacBook Pro are found at 
support.apple.com/kb/HT1411. Instructions for all other 
Macs are linked from support.apple.com/kb/HT1894.

In Search Of...Search Solutions

Leopard makes finding files and data on your Mac 
relatively trouble-free, but when it comes to search, there 
are improvements and tricks you can apply to make it even 
better. Here are two solutions to common search problems 
we hear about from a fair number of Mac users.

7. My Spotlight results have stopped working reliably.

If it’s a single non-Apple program that isn’t showing up 
properly in your Spotlight results, try turning off and on 
the Spotlight indexing in that particular app.

If you’re still getting Spotlight results for an app that 
you got rid of a while ago, you may not have completely 
deleted all of the data or databases that are associated with 
that program.
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Spotless gives you a nice GUI for managing, deleting, and 
rebuilding your Spotlight indexes.

If it’s an Apple program--or your entire Mac--that isn’t 
working properly in Spotlight, try re-indexing your whole 
hard drive by going into the Spotlight System Preference, 
clicking on the Privacy tab, then dragging your hard drive 
into the list. Wait a moment, and then remove your hard 
drive from the list again.

If you’re still having problems, you may need to bring out 
the big guns by using Spotless ($17, www.fixamac.net), 
a Spotlight index-management tool that can help fix most 
Spotlight problems.

8. I need more power, flexibility, and customizability 
with my Spotlight searches and Spotlight results.

Get HoudahSpot ($25, www.houdah.com), which lets you 
create extremely detailed search requests and customize 
the results to your liking.

HoudahSpot handles Spotlight searches with much more flexability 
than Apple’s built-in Spotlight search.

Three Essential Utilities

Three more Mac problems solved--before they happen!

9. Disk Warrior

($100, www.alsoft.com) This is a great preventative 
maintenance tool for rebuilding your Mac’s directory and 

keeping your mac running quickly and smoothly. It’s also a 
great emergency tool for repairing disks that have missing 
files or will no longer mount.

10. Cocktail

($15, www.maintain.se/cocktail/index.php). This general 
all-purpose utility will clean the caches on your machine, 
run the UNIX maintenance scripts, unlock hidden features 
of your Mac, and much more.

11. SuperDuper

($28, www.shirt-pocket.com). This disk cloning utility is 
great for backing up or transferring all the data on your 
entire computer to a fully bootable state.

Email and Web Problems

We know you spend most of your time in front of a Mac 
online or pounding out email. Here’s how to answer when 
trouble comes knocking.

12. I use a webmail client to check email, but every time 
I click on an email link, it launches Apple Mail instead.

You can set up Apple Mail to access your webmail account 
using IMAP or POP (check with your webmail provider for 
instructions on how to do this; some charge a fee for this 
service), or you can install the program Webmailer (free, 
www.belkadan.com/webmailer), which lets you set any 
webmail site as your default email program.

We set up Webmailer to take us to Yahoo’s webmail system 
whenever we click on an email link.

If you use Gmail, you have a few additional choices: You 
can install Google Notifier (free, toolbar.google.com/
gmail-helper) and set that to your default email client 
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in Mail’s preferences. Or you can use the outstanding 
Mailplane ($25, www.mailplaneapp.com), which provides 
many more features than the Gmail website.

13. I can receive but not send email messages.

Outgoing email messages are typically sent over the 
Internet using TCP port numbers 25, 465, or 587. However, 
in an effort to reduce spam, some ISPs and firewalls are set 
up to severely restrict the use of those ports. For example, 
AT&T is notorious for blocking port 25 for its DSL 
customers, unless you’re sending email with the AT&T 
email address assigned to your DSL modem. If you’re 
using AT&T (or another service provider that has similar 
restrictions), call the technical support number and request 
that they unblock port 25 for you. If you don’t control the 
Internet access where you are located, contact your email 
host to see if they have an alternate port that you can send 
email on. You can specify alternate port numbers in your 
email app’s account settings. If all else fails, you should 
be able to send email through your webmail system until 
you can physically get yourself to a different location that 
has no restrictions.

Our Web-hosting company, hostbaby.com, allows us to send email 
messages over alternate port 2525, which typically bypasses any 
firewall restrictions that have been put in place.

14. When I reply to or forward an email, the original 
message isn’t entirely quoted in my reply--sometimes just 
the header and a few characters are quoted.

If you used your mouse to highlight some text in the 
original email, and then you clicked on forward or reply, 
only the words that you selected will be quoted in your 
new email. To override this behavior in Mail (it can’t be 
overridden in Entourage), go into Mail’s Preferences, click 
on the Composing button, and you can set it to include 
all of the original message. If the problem still happens 
after this, your Mail preferences might be corrupt. Quit 
Mail, and trash the file located at yourhomefolder/Library/
Preferences/com.apple.mail.plist. Also try upgrading to 
Snow Leopard, which makes Mail more reliable in general.

The Composing preference in Mail ensures that your replies and 
forwards will always quote the original email message in their 
entirety.

15. I want to send an email later, not now.

Each email client handles this slightly differently.

In Entourage, choose Message > Send Message Later 
or click on the Send Later button. (In Entourage 2008, 
you’ll need to add the Send Later button to your toolbar 
by choosing View > Customize Toolbar from any outgoing 
message.) Your messages will queue up in your outbox, 
and then you can send them all at once by creating an 
Entourage schedule (Tools > Schedules) or by clicking 
the Send & Receive button.

In Thunderbird, choose File > Send Later. Your messages 
will queue up in the Unsent folder until you choose File > 
Send Unsent Messages.
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The Send Later Extension lets you schedule your outgoing 
messages in Thunderbird.

The Send Later Extension for Thunderbird (free, www.
unsignedbyte.com/?page_id=4) lets you schedule an exact 
date and time in the future to send your message.

Surprisingly, Mail provides no ability to send messages 
later. You could take all your accounts offline (Mailbox 
> Take All Accounts Offline) before clicking on the Send 
button, in which case your messages disappear until you 
quit and relaunch Mail to find a temporary outbox with 
your messages sitting in them. Or, to schedule emails for 
a later delivery time that you specify, install the Schedule 
Delivery script which is a part of Mail Scripts (donations 
requested, homepage.mac.com/aamann/).

Finally, LetterMeLater (free, www.lettermelater.com) 
offers another way to schedule emails to be sent at a later 
time.

16. I have multiple folders entitled Drafts, Sent, Junk, 
or Trash for my IMAP email account.

Setting up an IMAP account can be a little tricky. After 
typing your valid account settings into your email program, 
there are two additional steps:

First, you’ll need to set the proper IMAP path prefix 
(sometimes called the “root folder” or IMAP server 
directory) in your account settings. For example, Gmail’s 
IMAP Path Prefix is [Gmail].

Defining your IMAP server’s root folder is an often-forgotten step 
when setting up an IMAP email account.

In Entourage, you set this on the Options tab of your 
IMAP’s account settings. In Thunderbird, click the 
Advanced button on the Server Settings tab. In Mail, this 
is on the Advanced tab of your IMAP’s account settings.

Then you’ll need to designate which folders on the server 
should be used for storing your drafts, sent messages, trash, 
and junk. In Entourage, you set this on the Advanced tab of 
your IMAP’s account settings. In Thunderbird, this is done 
in the Copies & Folders section of your account settings. 
In Mail, go out to your main viewer window and select a 
folder on the server (in the left-hand margin, underneath 
the IMAP account name), then choose Mailbox > Use 
This Mailbox For.

17. Whenever I address an outgoing email, I get 
unwanted email addresses for people who aren’t in my 
address book.

Most email clients keep track of addresses that you’ve 
emailed to in the past and will suggest those addresses 
to you in the future when you start to type the same 
characters. You can turn off this feature in Entourage and 
Thunderbird by going into their preferences. In Entourage, 
this is found on the Compose tab. In Thunderbird, this is on 
the Composition > Addressing tab. You can’t turn off this 
feature in Mail, but you can clear the list from time-to-time 
by selecting Window > Previous Recipients, selecting the 
names and clicking Remove from List.

In Mail, you have complete control over your Previous Recipients 
list.

18. When I email long Web links to others, they 
sometimes get broken up onto multiple lines and don’t 
work correctly.

Try putting angle brackets (<>) around long URLs to help 
them travel safely across the Internet without “breaking.” 
Or you turn to TinyURL (free, www.tinyurl.com), which 
will turn those long URLs into, well, tiny URLs!
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19. I wish Safari’s built-in search field worked with 
more websites than just Google.

You may want to switch to Firefox, which has the built-in 
ability to customize its search field with any number of 
search engines that you specify. Otherwise, check out the 
Safari plug-ins Saft ($12, haoli.dnsalias.com) or Glims 
(free, machangout.com), both of which let you customize 
Safari’s Google search field. And one of our favorite 
utilities, iSeek ($15, www.ambrosiasw.com) lets you add 
a global customizable search field to your Mac’s menubar 
that works with any Web browser.

iSeek places a fully customizable search field in our 
menubar at all times.

20. I want to filter inappropriate websites so my kids 
can’t access them.

Although Mac OS X has built-in parental controls that you 
can turn on for individual accounts, you can gain more 
control by purchasing software like ContentBarrier ($50, 
www.intego.com) or Net Nanny ($39.99 a year, www.
netnanny.com). Even better, we’ve discovered that one of 
the quickest, easiest, and most effective ways of filtering 
all the computers in your entire household is to switch your 
DNS servers to the free OpenDNS servers (free, www.
opendns.com).

ContentBarrier is one of many options you have for blocking 
websites on your Mac.

21. My Internet connection is slow.

That’s a tricky one. A sluggish Net connection could 
be caused by any number of things, so here are a few 
troubleshooting tips to start with:

Try resetting Safari (Safari > Reset Safari). Then, try a 
different Web browser to see if the problem happens there 

as well. You may also want to uninstall any Internet plug-
ins that you have installed recently.

Next, check your upload and download speeds at www.
speakeasy.net/speedtest and see if you’re getting the speeds 
you’re paying for. If not, try power cycling both your 
modem and router, such as your Airport Extreme. Turn 
off or unplug the device, let it sit powered off for several 
minutes, then plug it in or switch it on again.

Our latest speed test from Speakeasy.net shows us that we’re 
not currently getting the full upload speeds for which we’ve been 
paying the big bucks!

If these methods don’t address the slowdown, try plugging 
your modem directly into your Mac using an Ethernet 
cable to see if the problem goes away. If so, your router 
may be the problem. If you’re using an Airport Extreme 
or Airport Express, launch Airport Utility to see if there 
is a firmware upgrade available. If so, install the firmware 
upgrade and see if that helps.

If not, your Mac could be the problem--you may need to 
perform an Archive and Install of your operating system, 
which is one of your options on the Mac OS X Leopard 
Installation DVD.

And it’s always possible that your modem or Internet line is 
the problem too, in which case you should call your ISP’s 
technical support number.

Photo Problems

These solutions to common photo issues will make you 
want to say “cheese.”

22. I need to quickly resize an image and make some 
color corrections to it, but I can’t afford Photoshop and 
don’t really want to learn how to use it.
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Preview has the built-in ability to resize images and adjust 
colors. Open up your image in Preview and select Tools > 
Adjust Size or Adjust Color.

This image-size adjustment dialog box is from Preview, not 
Photoshop!

23. I want to email photos from iPhoto through my 
webmail account by clicking on iPhoto’s Email button.

Even if you’ve installed Webmailer, as mentioned in 
problem #12, the email button in iPhoto will only work 
with four email clients: AOL, Eudora, Entourage, and Mail.

However, if you use Gmail, you’re in luck because 
Mailplane ($25, www.mailplaneapp.com) installs an 
iPhoto plug-in that lets you click on iPhoto’s Email button 
and send your messages through your Gmail account.

In any dialog box, you can activate QuickLook when browsing your 
iPhoto Library by selecting a photo and pressing the spacebar.

Otherwise, go into your webmail program, and attach 
photos using the standard method. Leopard’s dialog boxes 
give you the ability to browse through your iPhoto library, 
and they even let you use QuickLook by clicking on a photo 
and pressing the spacebar.

24. I want to use iPhoto ‘09 to export photos to 
Facebook, but there are too many problems with it.

Forget about using iPhoto ’09’s poorly implemented 
Facebook “integration.” Instead, use the outstanding 
Facebook Exporter for iPhoto (free, developers.facebook.
com/iphoto).

Use Facebook Exporter for iPhoto to tag, add captions to, and 
upload your Facebook photos right from within iPhoto.

25. I created a PDF file with lots of embedded photos 
in it, but now the file is way too large to email.

Open up the large PDF file in Preview and select File > 
Save As. Where it says Quartz Filter, choose Reduce File 
Size, then click Save. Voilà! You’ve now saved a much 
smaller version of your PDF file, which will be easier to 
email.

Choose this Quartz Filter in Preview to reduce the size (and 
quality) of large PDF files so you can email them without choking 
your email server.
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For even more control over the resulting quality of PDF 
size reduction--and to batch-process multiple PDF files at 
once--try PDFshrink ($35, www.apago.com).

If you still can’t get the file small enough for your needs, try 
a file-sending service such as YouSendIt (www.yousendit.
com).

26. Somebody emailed me a PDF file with lots of 
embedded photos in it, and I need to extract the photos 
from the file.

File Juicer ($18, www.echoone.com) will extract images, sounds, 
and more from any filetype.

File Juicer can extract all these types of files out of other 
files.

Office/iWork Problems

Work smarter not harder with these troubleshooting tips 
for common productivity apps.

27. I created an awesome slide show in Keynote, 
but I have to present it on a PC. I tried exporting it to 
Microsoft PowerPoint format, but I lost my transitions, 
effects, transparencies, gradients, and more--basically, all 
the cool stuff.

Export your Keynote file to a QuickTime movie instead. 
As long as the PC has QuickTime installed on it (which 
it should, if it has iTunes installed), you’ll be able to play 
back your presentation with all of its awesomeness intact. 
If the PC doesn’t have QuickTime, download it for free 
from www.apple.com/quicktime.

With the “Fixed Timing” option, we can set our QuickTime movie 
to automatically advance to the next slide on a regular interval.

When you export your movie, you have several options 
for how it should advance from one slide to the next. For 
example, if you set it to manually advance, you simply have 
to press the spacebar on the PC to move to the next slide.

28. I’ve included presenter notes (View > Show 
Presenter Notes) in a Keynote slide show, but when I 
play or rehearse the slide show, the notes don’t show up 
onscreen.

In Keynote’s preferences, click on the Presenter Display 
button, and check the boxes for Notes and “Use alternate 
display to view presenter information.” Now your notes 
will show up when you play or rehearse your slide show.

This checkbox lets you toggle between mirrored displays and 
dual displays.

However, if you start seeing your notes on both your 
computer screen and the projector’s screen, your computer 
is set to mirrored (instead of dual) displays. You can toggle 
these display modes while the projector is connected to 
your Mac by launching System Preferences, choosing 
Display > Arrangement, and deselecting the Mirror 
Displays checkbox.
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29. I use Office 2008 to create Word, Excel, or 
PowerPoint files, but my Mac-using colleagues can’t open 
the files because they’re using Office 2004.

TextEdit can open and edit Word 2008 files. And if your 
colleagues have iWork ’09 installed, they can work with all 
of your Office 2008 files in Pages, Numbers, or Keynote.

Otherwise, you’ll need to save the file in an earlier file 
format. Choose File > Save As and select the format that 
corresponds to Office 97–2004. You can also set this older 
format as the default in your preferences for Word, Excel, 
and PowerPoint.

Choose the .doc format to avoid compatibility issues with people 
using earlier versions of Microsoft Word.

Alternatively, your colleagues can install Microsoft’s Open 
XML File Format Converter (free, www.microsoft.com/
mac/downloads), which will convert your Office 2008 files 
into a format that Office 2004 can read.

Syncing Problems

Data syncing can be particularly stressful since we need 
access to info anywhere these days. We’ve got solutions.

30. I want to sync some--but not all--of my iCal 
calendars across my Macs.

Don’t use MobileMe to sync, which always synchronizes 
all of your calendars. Instead, use BusySync ($25, www.
busymac.com) or BusyCal ($40, www.busymac.com), 
which both give you an incredible amount of syncing 
options.

BusyMac’s products are true champions when it comes to 
publishing and subscribing selected calendars without any 
dedicated servers.

31. I want to synchronize my iCal calendars and Address 
Book on my Mac to Outlook on a PC.

Sign up for MobileMe ($99 a year, www.apple.com), 
which will keep all of your Macs and PCs (and iPhones!) 
in sync with each other.

Spanning Sync effortlessly syncs your calendars and contacts 
to Google.

Or, you can use Google Calendar and Google Contacts as 
a conduit. On the Mac side, you’ll need Spanning Sync 
($25/year or $65/one-time purchase, spanningsync.com). 
On the PC side, you’ll need Google Apps Sync ($50/year, 
tools.google.com/dlpage/gappssync).
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32. I keep getting duplicate entries on my iCal calendar.

Sounds like you’re trying to sync your Entourage calendar 
with iCal. There’s a known bug with Entourage that causes 
repeating events to multiply out of control in iCal. We 
don’t know of any long-term solution at this time except 
to ditch Entourage’s calendar and stick to iCal for your 
calendaring needs. To do this, uncheck the box for syncing 
events in Entourage’s Preferences (on the Sync Services 
pane). To erase iCal dupes, try iCal Cleaner (free, www.
busymac.com).

33. I’m getting two of each calendar entry on my iPhone.

You may be trying to sync your calendars through both 
iTunes and MobileMe. You’ll need to choose one method 
or the other, not both. If you’re syncing wirelessly through 
MobileMe, then go into your iPhone settings within iTunes 
and uncheck all of your calendars there.

The exception to this rule is iCal’s Birthdays calendar 
(enabled in iCal’s preferences, this calendar pulls birthdays 
from your Address Book), which can only be synced 
through iTunes, so it must remain checked in iTunes.

34. My U.S. Holidays and other Internet-subscribed iCal 
calendars are not syncing between my Mac and my iPhone.

Any Internet-subscribed calendars must be resubscribed 
to directly from your iPhone. You can manually set up 
the server on your iPhone by going to Settings > Mail, 
Contacts, Calendars > Add Account > Other > Calendars.

You must resubscribe to your iCal holiday calendars on your 
iPhone all over again.

Or, you can automatically subscribe to a calendar by using 
Safari on your iPhone to choose from Apple’s extensive 
selection of calendars at www.apple.com/downloads/
macosx/calendars.

35. iTunes no longer launches automatically when I 
attach my iPod or iPhone to my computer.

If your iPhone or iPod is very low on power or if the battery 
is fully depleted, it can take up to 10 minutes to appear 
under Devices in iTunes.

Otherwise, you may have unchecked the box in iTunes 
for your device that says “Automatically sync when this 
iPhone/iPod is connected” or “Open iTunes when this 
iPod is attached.”

You may have also removed the iTunesHelper application 
from your Login Items in your Account System Preferences, 
which is required to automatically launch iTunes. You can 
get this back by reinstalling iTunes (www.apple.com/
itunes) or by manually dragging iTunesHelper into the 
Login Items. iTunesHelper can be found by right-clicking 
on iTunes in the Finder and choosing Show Package 
Contents, then going to Contents > Resources.

36. I want to synchronize files between two computers.

There are many different programs available to help you 
with this task, but our favorite is ChronoSync ($40, www.
econtechnologies.com). ChronoSync can automatically 
mount remote servers, wake your local Mac from sleep, 
schedule your synchronizations, archive backup copies 
of your files before syncing, and even give you a list of 
proposed changes before it makes any of them.

Synchronizing files between two different computers is as simple 
as drag-and-drop with ChronoSync.
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While you can use ChronoSync to synchronize to any type 
of volume or folder, if you specifically want to sync to 
another computer, you may want to additionally purchase 
ChronoAgent for an extra $10. ChronoAgent lets you 
communicate directly with a remote Mac faster than using 
AFP or SMB, and you gain full root access, so you can 
copy anything without any restrictions.

37. I turned on MobileMe syncing on my iPhone, but 
nothing is syncing to my Mac or Me.com.

It’s possible that the MobileMe servers aren’t 
communicating properly with your iPhone. An Apple 
support rep recently admitted to us that this is an extremely 
common problem that MobileMe users may experience 
every few months until Apple increases the reliability of 
its MobileMe syncing servers. So you may want to keep 
these instructions handy for future reference.

First, find out if MobileMe sees your iPhone at all. 
Activate Find My iPhone on your iPhone (Settings > Mail, 
Contacts, Calendars > your me.com account > Find My 
iPhone). Then, from a computer (not your iPhone), go to 
your MobileMe account page at https://secure.me.com/
yourusername. Click on Find My iPhone to see if the 
MobileMe website sees your phone. If not, try turning off 
your iPhone and turning it back on again. If the MobileMe 
site still doesn’t see your phone, try deleting your 
MobileMe account on your iPhone and re-creating it again.

We feel like Big Brother is watching us with Find My iPhone’s 
crosshairs centered directly on our house!

Once Me.com sees your iPhone, try adding an event or 
a contact to your phone and see if the change shows up 
on your MobileMe calendar (www.me.com/calendar) 
or address book (www.me.com/contacts) within a few 
minutes.

If not, you will probably have to reset all of your sync 
data on Me.com with information from your Mac’s iCal 
and Address Book. Make a mental note of any recent 
unsynced changes you’ve made on your iPhone, because 
you’re going to lose them in this process. Also, sign out 
of Me.com. Go into the MobileMe System Preference on 
your Mac, select the Sync tab, click on Advanced, and then 
click Reset Sync Data. Click on the right arrow so that you 
are replacing all sync info on MobileMe with “info from 
this computer.”

Log back into Me.com and verify that it now has your 
current information for contacts and calendars. If not, you 
will have to reset the SyncServices database on your Mac. 
Apple has instructions on this process at support.apple.
com/kb/TS1627.

But before following those instructions, be sure to do two 
things on your Mac: First, repair your permissions using 
Disk Utility (Applications/Utilities), and, second, repair 
your keychain using Keychain Access (in Disk Utility, pull 
down from the Keychain Access menu and select Keychain 
First Aid). After that, try syncing again from the MobileMe 
System Preference pane.

This is how it should look when you’re about to overwrite information 
on the MobileMe website with information from your Mac.

Once Me.com has your current information, you are ready 
to go back to your iPhone. On your iPhone, go to Settings 
> Mail, Contacts, Calendars > Fetch New Data. Turn Push 
off, then completely turn off your phone for 30 seconds. 
Turn your phone back on and re-enable push. Then, go 
to Settings > Mail, Contacts, Calendars > your Me.com 
account and turn off and on each one of the sliders for the 
information that you’re trying to sync (Contacts, Calendars, 
Bookmarks, etc).
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Wait several minutes, and hopefully all your current 
information will reappear in your calendar and contacts 
on your iPhone.

If not, you will probably need to have a live chat with a 
MobileMe support agent. Go to www.apple.com/support/
mobileme. Choose any of the troubleshooting options 
underneath Syncing with MobileMe in the left-hand 
margin, and a Chat Now button will appear.

Video Problems

These tips address problems you might encounter trying 
to play video files on your Mac.

38. I’m trying to use my Apple Remote on my Mac to 
watch movies through Front Row, but the other computers 
in the room--along with my Apple TV--are inadvertently 
responding to my remote’s button presses.

You need to pair each one of your Apple Remotes to a 
particular device. Apple has instructions on how to do this 
at support.apple.com/kb/HT1619.

39. Sometimes I can’t play Web videos.

Out of the box, your Mac can only play Flash and 
QuickTime videos. To play other video formats, you’ll need 
to install one or more of the following free apps:

>> Flip4Mac Windows Media Components for QuickTime 
(www.microsoft.com/windows/windowsmedia/player/
wmcomponents.mspx)
>> Perian (www.perian.org)
>> Microsoft Silverlight (www.microsoft.com/silverlight/)
>> RealPlayer (www.real.com)
>> VLC (www.videolan.org)

40. I want to convert video files to other formats, 
particularly those that will work on my iPod or iPhone.

To convert your video files into many different formats--
including iPhone and iPod compatible formats--try Video 
Monkey (free, videomonkey.org), VideoDrive (7.99 
euros, www.aroona.net), or CosmoPod (8.90 euros, www.
cocoamug.com). To convert DVDs, try HandBrake (free, 
www.handbrake.fr).

41. I want to download a Flash video from the Web.
There’s a little-known trick in Safari that lets you download 
Flash videos that are embedded in webpages. Bring up the 
Activity Viewer (Window > Activity) and look for a file 
that appears that it may be your video file, perhaps based 
on its large size or the fact that it is so large that it is still 
loading. When it‘s finished loading, hold down the Option 
key and double-click on the video file. Safari will download 
the file into your Downloads folder for you, and you can 
monitor the progress through the Downloads window.

Little-known Safari secret: You can download Flash vids, like Funny 
or Die’s famous “The Landlord” starring Will Ferrell, to your Desktop 
to watch at your leisure.

If you’d like an easier way to download Flash videos, try 
TubeTV (donations requested, www.chimoosoft.com), 
Videobox ($15, www.tastyapps.com), or TubeSock ($15, 
www.stinkbot.com).

42. I want to download a QuickTime video from the 
Web to my Mac, so I can watch it later.

If you’ve purchased QuickTime Pro ($30, www.apple.
com/quicktime), you can download many QuickTime 
videos right from the Web by clicking on the triangle in 
the lower right-hand corner of the video and choosing Save 
As QuickTime Movie.

However, some QuickTime videos, including those on 
Apple’s website, don’t let you download them directly. 
To download these devious videos--with or without 
QuickTime Pro--view the source of the webpage in Safari 
(View > View Source) or Firefox (View > Page Source). 
Do a search for .mov (the file extension for QuickTime 
videos) to find the full URL of the video file. When you 
find it, copy the entire URL of the video file. Then, launch 
QuickTime Player on your Mac and select File > Open 
URL and paste in the URL. Now you can save the video 
file onto your computer.
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43. I bought an external USB webcam, but my Mac 
laptop isn’t recognizing it.

If your Mac is running Mac OS 10.4.11 or later, it can 
recognize almost any USB webcam on the market, usually 
without installing any drivers.

If you’re running the latest version of OS X but still having 
problems, the iUSBCam (www.ecamm.com/mac/iusbcam) 
and macam (webcam-osx.sourceforge.net) websites 
provide helpful tips and driver downloads.

Note that Mac programs like iChat and Skype will first 
try to use your built-in internal camera before using any 
external webcams. To change this, you’ll need to go into 
the preferences of those programs to change your video 
input source.

If you’re unsuccessfully trying to use your external 
webcam in Photo Booth, you have to switch back to the 
internal camera in iChat’s preferences before launching 
Photo Booth.

Music Problems

How to keep rocking in the free world.

44. I want to make iPhone ringtones from a song that I 
didn’t purchase (or isn’t available for purchase) from the 
iTunes Store.

If you have a track in iTunes that you own on CD and that 
you’ve ripped to iTunes, you can make a ringtone from 
it for free in GarageBand ’09. Click here for instructions 
and scroll down to “Roll Your Own iPhone Ringtones,” 
which also provides instructions for doing the same thing 
in QuickTime Pro).

45. My iTunes library is full of duplicates.

For smaller libraries, use iTunes’ Show Duplicates feature 
(File > Show Duplicates) and manually remove the extra 
files. iTunes only matches on Artist and Title information 
though, so be careful not to delete legit alternate versions 
of tracks--live versions, for example. For better duplicate 
control, try Dupin or some of the iTunes scripts available 
at www.dougscripts.com.

46. One of the rubber tips from a pair of third-party 
earbuds got stuck in my ear--help!

Believe it or not, this has happened to us too--more than 
once. We recommend keeping a pair of tweezers handy, 
just in case a tip come off in your ear canal, which can 
sometimes happen if you pull the ’bud out too quickly. It’s 
happened to two Mac|Life editors, both of whom agree that 
having something small and unreachable lodged in your 
ear can be pretty traumatic.

47. My iTunes library is spread across multiple Macs. 
How can I keep two iTunes libraries synchronized?

If all you want to do is listen to iTunes music housed on 
another local Mac (i.e. connected to the local network), 
just turn on iTunes’ sharing feature (Preferences > Sharing 
and check “Look for shared libraries”). To share your own 
tracks, also check “Share my library on my local network.” 
You can also store libraries on a network drive that supports 
iTunes sharing, to share tunes without needing another 
Mac up and running all the time. To keep two libraries 
in step for syncing iPods, use a utility like TuneRanger 
($29.99, my.smithmicro.com) or SuperSync ($29, www.
supersync.com).

You don’t have to share all your iTunes content--and you can 
password-protect it if you want, too.



December 2009

25

Th
e GAB’er

Backup Problems

Don’t tell us you don’t back up--especially since Time 
Machine makes it so easy! Here’s what to do when you 
run into problems.
 

48. I want to restore a file from a Time Machine backup 
of a different Mac or an older backup of my main Mac that 
Time Machine no longer recognizes (due to a new backup 
drive, a new logic board, or a new internal hard drive).

You can restore any Time Machine backup onto any Mac, 
if you know a few tricks involved with restoring.

The first one is related to an odd decision by Apple: You 
can only browse other Time Machine volumes by adding 
the Time Machine icon to your dock, then right-clicking on 
the icon and selecting Browse Other Time Machine Disks.

There’s our hidden option to browse other Time Machine disks!

But even if you do that, it won’t see your Time Capsule 
or other external Time Machine drives, even if they’re 
mounted on your Desktop. In Finder, you actually have 
to manually choose the .sparsebundle file that represents 
the computer that was backed up, double-click on this 
file, let it mount on your Desktop, and then Time Machine 
will let you choose the resulting mounted disk image to 
restore from.

49. Time Machine is giving me an error message that’s 
too vague for me to interpret.

The programs TM Error Logger (donations requested, 
www.carnationsoftware.com) and Time Machine Buddy 
(free, www.bluedog.com.au) can help you interpret what 
has gone wrong with your Time Machine backup.

50. I’d like Time Machine to back up to multiple external 
hard drives, so I can keep one backup drive offsite and one 
backup drive onsite.

Time Machine can correctly keep track of backups on 
multiple external hard drives. Just give your hard drives 
different names, and whenever you connect the other drive, 
you’ll need to manually make a trip to Time Machine’s 
System Preference and change the disk there.


